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Automated Driving Cloud Services Internet of Things UX Applications

ij 36 % @y

Cars with over-the-air 66% of OEMSs plan to New vehicles based on common
capabilities by 2026 partner with software firms software platforms grow from
and system integrator firms 7% today to 35% by 2031

Shared Mobility

@ $640 billion

By 2031 software-based
features and services will be
a market worth $640 billion
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A radical shift in the automotive industry

PAST

Distributed Architecture

HPC: High-Performance Computer

Up2now

TODAY

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

REVOLUTION |

Server-Zone Architecture with
domain / x-domain HPCs

EVOLUTION

FUTURE

,,,,,,,,,,,,,,,,,,,,,,,,,,

d6d &0

Server-Zone Architecture with
Central HPC
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Transformation of Mobility
The car Is turning into a system within a system of systems

Financing

Internet Connectivity

A @ Health
} 0—0

Cloud
Platform

Services

Aftermarket

475

Service

Mobility
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Service-oriented Architecture as Transformation Enabler

Continuously field
data inflow to
improve algorithm
& product

Reduce test effort

' bl and time on the
0 road by >50%
\ Q 0

New
business
models
Data-driven
development
Virtual
development
Shorter
development,
“Code to road” test an_d
within 1 day integration
cycles

Software as a Product, or Service

HW/SW/Services until EOL .
( v Hntl ) (SaaS) business models

RFQ SOP EOP EOL
Software Digital Predictive
separation G Twin Maintenance Open
from Functions/Applications Cloud Services architecture
hardware for 3" party

) Qp
{:} Automotive SW Platform o, software

%ﬁ} Continental HPC Platform Data Center

Shorter time % Shorter time for vehicle SOP
to market A\ with increased platform lifetime

HW: Hardware; SW: Software; HPC: High-Performance Computer; RFQ: Request for Quote; SOP: Start of Production; EOP: End of Production; EOL: End of Life

(Ontinental® HMG TechDay

Automotive © Continental AG

Public

3/15/2024



Software-Defined Vehicle (SDV)
extends business lifecycle

I Going forward

Up2now I—

Value per vehicle*
A ™

\oY
Depse

pdd-on SW _
functions > Complexity Management

Software & functional growth
maintenance Q

@ 2 integration ) @: | ; _ @

Vehicle purchased Vehicle end of life

* Not to scale; for illustrative purposes only

@minentali HMG TechDay Automotive © Continental AG 3/15/2024 8
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Enable. Develop. Int

In the_ Software-defined Vehicle (SDV), ’ T
functions are enabled by software. B Digital Twin .o
: Cybersecurity ;

Decoupling software from hardware In-Vehicle

enables swift and continuous development,

testing & implementation of new functions it o~
" " ontinuous
and software updates throughout vehicle SeRiRvs ' Development/
2 5 : Validation/
lifetime. : ! Testing
os/
Middleware Y
Data Security
In-Cloud
OUR APPROACH:
The road to cloud ecosystem
B . ) AT s : S A | ; Lifecycle

Within this we deliver: N . ' Management ; 2

enabling technologies, v \ ‘ 3 , -
hardware components and U
software solutions and functions. )
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CAEdge

Continental

Automotive Edge _
Framework The Comprehensive

Framework for Automotive
Software Development

Public



<

CAEdge is the ecosystem to embrace
software-defined vehicles, from
architecture to software integration.

With the most diverse building blocks,
it is the tool set for individual
development, optimal collaboration,
testing and validation.

X4



Our Approach: Continental Automotive Edge Framework
Our Full-Stack loT Architecture Solution

Yo
DevOps Workbench r_%%%)
S

)
High-Performance Computer Cloud aws
= D Functions / Applications I]:% Cloud Services
.l
. Automotive SW Platform

Middleware
.l . @8 A ;OP Simulation & Validation
m @)@ / ) ¢ ©  Services
@ @ . j Core SW/OS

Continental HPC Platform [ Data Center
Vehicle Infrastructure

Software-defined vehicle

* uP: Micro-Processor, SoC: System on Chip, SoM: System on Module; CI/CD: Continuous Integration / Continuous Deployment

Public



CAEdge

IS a cloud-based framework for:

— = g g e

SW development decoupled from HW development

\ Y.
y
. 4

Seamless collaboration

Validation and improvement of system functions

(Ontinental

HMG TechDay Automotive © Continental AG 3/15/2024
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Continental Automotive Edge Framework
Key for SDV Development and Deployment

v /
With CAEdge yotfcan:

Virtualization/ |
| Connectivity : Digital Twin

Cybersecurity‘ . . v\ Evaluate |
In-Vehicle By ‘ v your SW-architecture before
adiaiil | you build physical devices

Software 7 i = :;‘_Y/;"‘WV
Solutions evelopment/ ZN/)
| Validation/

Testing 4 Run ¥
a new function within 1 day in
any physical car at anytime

( Data Securith — m‘ N

~ In-Cloud
‘ Share
the same target hardware for all

Lifecycle \ developers worldwide instantly
Management '

e —

\

_the-ai Gt , Drive )
S8 Zone § )y O\L/Jerdthte air S s e - _ _ _

| Architecture | ‘ ‘ Pifes=> e 1 million km in simulation at

your desk in 1 day

L &




VECU Creator

Cloud-based Workbench for Software Development
Continental Cooperation Portal

Hardware Development Kit HDK 2.0/3.0
Hardware Farm

Workbench for Data-driven Development

Public



Automotive System Development from lIdea to Roll out in Just a Glimpse

CAEdge enables faster
development and deployment

CAEdge provides interchangeable
building blocks

Customers can start immediately

Public

Modular and scalable compute
platform

Automotive grade designed
building blocks

Cohesive, integrated tool
framework

Non-differentiating automotive-
grade OS and middleware

Cloud as scalable extension of
embedded and on-prem resources
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Hardware is simulated to
run the real target binary
software on a PC

Target to test:
MCAL/BSW functions

SYNAOPSYS' Virtualizer

Lower software layers are
simulated to run target C
codeonaPC

Target to test:
BSW functions
ECU communication
ASW functions
SW modules

SYNOPSYS' Silver

MCAL: Micro Controller Application Layer; BSW: Basis Software; ASW: Automotive Software

Public

Several ECUs are simulated
to run ASW functions and
their interactions

Targets to test:
ASW functions
SW modules
ECU communication
Network/cloud services

8 CAEdge

All relevant ECUs are
simulated to run all system
and ASW functions as well
as their interactions

Targets to test:
System functions
ASW functions
SW modules
Communication
Network/cloud services

In the future



Development Workflow

O

=

Continental HPC HW
uses

) provide
— —

push artifacts to artifacts
CCP Artifactory

Prepare/
commits to Build
s __ push —_
sources

manage and
monitor

—>| Store

h 4

Deployment

Artifact

(S3, ECP)

deploy

|

aAWsS

Cloud

AWS loT

CCP Github

Cloud services and connectivity by AWS
Variety of instances
Simulated and real devices (VHPC / HPC and ZCU)

AWS: Amazon Web Services (v)HPC: (virtual) High-Performance Computer ZCU: Zone Control Unit

s

Virtual HPC

Public

ull artifacts Cloud
P Connector
[
AUTSSAR #r@NIX Android asd @
Containers




Digital Twin of the Physical HPC

_ ; Virtual HPC
5 Instances available

In the VECU Creator

aws

Instance Federation

v
Classic Autosar Adaptive Autosar QNX Android Linux
(Cloud Simulator) (Cloud Simulator) (Cloud Emulator) § (Cloud Emulator) (Cloud Emulator)

=
o
9

f ) [ Autosar Runnables ] Autosar Applications [ QNX Applications ] ] [ Android Applications ] [ Linux Applications ]

Sensor Data )
Remission Synopsys Silver Adaptive Stack
|\ J
5 . Package Management System [ Package Management System] s < g [ Package Management System] = Package Management System
3 |5|E > T
= == g_ =
Test Framework ) Ubuntu RM Linux Distribution RM QNX RootFS % % g RM Android Distribution g % RM Linux Distribution
L ) AWS EC2 Graviton AWS EC2 Graviton AWS Graviton § § g AWS Graviton s § AWS EC2 Graviton
J
T T A A T
( N\
CAEdge DevKit : : A . o
9 Car Bus Simulation “Interior Light” ... Innovation Platform Cluster Application TBD

Workbench Assets

(.
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A SW-Architecture & System Validation

A
\/

Open SW-Bugs

Late SW bug findings.
Vehicle SOP in
danger!!

Target:
bug free SW.
Smooth vehicle s .
SOP Mostly bug fixing in

task force mode

>
A &
FeatureContent § e ————
100% Low customer satisfaction
>
SoC on Target ECU HW Specification HW Development A-Sample B-Sample C-Sample | Raé‘nopPUp @ Series D — Actual Development CyCleS

Public



Open SW-Bugs

A

A
v
A
v

Target:

Feature Content
100%

SoC on Target ECU

SoC on Target ECU

bug free SW.
Smooth vehicle
. SOP
Earlier start
of SW testing
and bug fixing
Cl/ICT
- TS
Feature
Increase
VECU-
HW Specificati Ramp Up q
pecification HW Development A/B-Sample C-Sample sop Series

T~ T
| ["55" @ s >

Public

Higher customer satisfaction

Development supported
with vVECU

—— Actual Development cycles



Advantages

Risk reduction by separation/
decoupling from SW-architecture
validation and system validation

Resource-saving development
Save costs for samples

Save costs for HiL tests through the
use of in parallel virtual tests

Public

Smooth entry into series
production

Reduction of task forces
Faster SOP

Faster transition to update/
upgrade development mode

Higher customer satisfaction



Demonstration Projects

art Cockpi
mmmmmmmmmmmmmmmmm

Example: Virtualization of Smart Cockpit HPC

Public



Integration and Test Strategy for Multiple Partitions — Testing

Build (CI) Testing/Test execution (CT)

Digital Twin Digital Twin Digital Twin

3 Linux Autosar
)

Digital Twin

(Virtualization) Android

-
User: Partition test
—» Partition S——
developer soc EEERIA  partion
Partition Cloue loue Clouc integration test
Integrator
Virtual Peripheral Virtual Peripheral Virtual Peripheral
Smart cockpit HW Smart cockpit HW Smart cockpit HW
Smart Cockpit Android < W R Test
4 ‘i
Hardware — - Partition
User: integration test
L

Smart cockpit _
System Hardware /SoC

Target ECU SoC (4*A72 Core, ARM64) test

HW Peripheral HW Peripheral HW Peripheral

*HPC: High-Performance Computer; SoC: System on Chip; BSP: Board Support Package

Integrator
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Function Application Layer / HW Backbone Provider

Hardware Backbones
High-Performance
Computer (HPC)
Zone Control Unit
(ZCU)

e

Public



Vehicle e B =~ - NCOCKDINNPE
Control HPC i~ ) - (Cluster + Infotainment)

Software > o : — S

Development & (O EY WU — 1 Automated Driving
Integration, GRS = ‘ -y HPC
Virtualization L ; .

System Exploration \ _ proa e \ ADAS-Cockpit (AC)
Kit (Reference Integration) & : HPC

Mechanical = sl S L3
Housing and S SR AN ) 7 Central HPC

Cooling Solutions
(Cooling, Rack & Stack concepts)

> Architecture & Consulting >> HW & SW Development >> Integration & Testing >> Production & Maintenance >




From Domain Centric Towards Central HPC
Overview About Domain Migration

Domain Centric Domain Migration

Automated Driving HPC

ADAS-Cockpit HPC [AC HPC]
(AD L2+ Cockpit)

Cockpit HPC

Central
HPC

Various combinations of
x-Domain HPCs

Vehicle Control HPC [VC HPC]
(Body + Chassis & Motion)

*HPC: High-Performance Computer

(Ontinental® HMG TechDay Automotive © Continental AG 3/15/2024 30
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Cockpit High-Performance Computer
Scope

m “The journey started integrating infotainment and cluster functionalities in one device. Features are continuously added (e.g., cameras, ...)”

Entertainment
Digital Assist

Audio Sound
Speech

Infotainment

Driver Monitoring
Cabin Sensing

Augmented Reality
Head-up Display

Machine
Vision

Human
Vision

Function List ——————

» Cluster
> Infotainment
> Radio
> Media
> Navigation
> Phone
» Connectivity
» Audio, Sound, Speech
> Augmented Reality
» Head-up Display
» Display
> Entertainment
» Co-Driver Entertainment
> Rear-Seat Entertainment
» E-Travel Companion
» Diver and Cabin Sensing
> Human Vision
» 360 deg View
» Digital Mirror
» Machine Vision

@ntinentali\ HMG TechDay Automotive © Continental AG
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Consumer
Technology

In Collaboration With Google Cloud

LT ——

Collaboration with Google Cloud =, GO ‘g[e

(Onting;

“54@ Powerful processor of the Telechips Dolphin family

@ Pre-integrated functions for cluster, infotainment and
«I= visualization of Advanced Driver Assistance Systems

./C —
N — %

Cost-optimized and with a short development time

Public



Combining ADAS and Cockpit Functionality (AC HPC)

EOEKRII Audio Sound
Speech

Entertainment
Digital Assist

Augmented
Reality

[DIRIWVAIN[E

Safety AUMGNANE

Parking

A ADAS

Cruising

Driver &
Cabin Sensing

______________________________________________________________

.

Cockpit
Cluster
Entertainment & Digital Assist
Co-Driver Entertainment
Rear-Seat Entertainment
Infotainment
Radio, Media
Navigation, Connectivity
Audio, Sound, Speech
Augmented Reality

Automated Driving

Diver and Cabin Sensing
Cruising

Traffic Jam Chauffeur
ADAS Visualization
Parking

Valet Parking
Safety

Lane Departure Warning

HMG TechDay

Automotive © Continental AG
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Consumer

. . . Technology
Combination of Cockpit and ADAS

‘ First driving vehicle with a
i cross-domain AC HPC

¢ InnovationPlatform

Cockpit

Combining cockpit and
ﬁﬁ ‘ advanced driver assistance
features on one chip

MotionControl TR = e R
Software
o ‘ Milestone on the path towards
&) ot i Integrated Brak
full domain integration Ultrasonic Sensors sny:ger:\MKéaz "
Surround Vie ‘ 3 Surround View
System e S Cameras

; Yl
/A 14y
Y1
/ /{/ i1l l’/' /

Public



Automated Driving HPC
Integration of Assisted and Automated Driving Functions Into One Device

“ADAS functions such as visualization, parking, driving from L2+, and combinations of these functions can be hosted on one device”

Cruising

Function List —c——————

> Parking, e.g.
» Automated Parking
> Valet Parking
> Cruising, e.g.
» Driver Montoring
» Traffic Jam Chauffeur
> Human Vision, e.g.
> Surround View
» Transparent Hood
> Safety, e.g.
> Lane Departure Warning
» Blind Spot Monitoring
> Perception
> Backend Functions e.g.
» Big Data
> Maintenance / OTA

Maintenance |

OTA Human

Vision

Backend / loT
Functions

. Driverless
Perception

@ntinentali HMG TechDay Automotive © Continental AG 3/15/2024 35
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__1
- Automated Driving HPC CES

WL
> Ly

%,
/

W, §
KT

P
4 iy,

» %,

%,
O

NI
o ",

- -
W o
W™

g,
%

o
2 L
Uy ! a
M

D\

< IS,
) ‘ AD HPC hardware for fully driverless ‘ .
(L4) operation of long-haul trucks fay

U
Iy W
"mnm ™

| ADCU for full-stack fallback-path

‘ Partnership with Ambarella - Software Stack for
% assisted and automated driving

Automotive © Continental AG
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Vehicle Control (VC) HPC
Host for Vehicle Control Core- and Cross-Domain Functions

11 A 7 7 A A H'H H H LL) VC Core Hosted
We integrate vehicle infrastructure and cross-domain functionalities into one device... Fuywmons,

Safety &

Motion

Communication
Function List
> Communication

> Routing, Gateway, ...
> Security

> Gateway, Key Management, ..
> Maintenance / OTA

> OBD Diagnostic, SW Update, ...
> Backend/loT

> Predictive Maintenance

Maintenance/ - % ! ) Big Data (collection), ...

BEV
Powertrain

OTA > Safety & Motion
Over the Air > Holistic Motion Control (HMC), ...
Update .

> BEV Powertrain

> Powertrain: Electric
> Charging Management, ...
> Body
> Exterior/Interior Light
> Air Conditioning, Seat Control, ...

Passive Safety > Passive Safety
> Tire Pressure Monitoring

Backend/loT

> Driver Health Monitoring, ...
BEV = Battery Electrical Vehicle, OBD = On Board Diagnose

@ntinentali HMG TechDay Automotive © Continental AG 3/15/2024 37
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Vehicle Control High-Performance Computers

GAC

VC HPC Hybrid HPC
Base Platform (HPC/ZCU)

Source: https://insideevs.de

Integration host for vehicle control functions

Volkswagen ICAS1
for ID.Series

QP
o-d\O

Central data and communication hub

Master for over-the-air software
update and upgrades

Vehicle cyber security master

*ZCU = Zone Control Unit; ICAS1 = InCar Application Server
Public



Essential Components to Realize the SDV

Manage complexity +
Reduce total vehicle system cost

Consolidate I/0Os and reduce
ECUs

Optimize power & signal
management

Low effort Variant Management /
fast time to market

SOA Introduction - “Place” for
Real Time Functions and StS*
conversation

—

Public

ZCU allows x-domain zonal

management of signals, data & power!

Standardized data/service interfaces

Signal-to-service conversion between
sensors/actuators & HPC

Hosting time critical real-time functions

Ethernet backbone connection to HPC

CAN, CAN-FD, LIN, 10MBit Ethernet for
zonal network

Translation between service-oriented and
signal-oriented ECUs

Intelligent power distribution and diagnosis
Smart fusing/switching up to 40A

Redundancy (support ASIL-rated power
distribution)

StS: Signal to Service



Real X-Domain Hub Enabling Service-Oriented Architectures

Main ECU of a physical
vehicle zone

Located in the vicinity of the
sensors/actuators and
peripheral devices

Hub for x-domain zonal management
of signals, data and power

@ntinentali HMG TechDay Automotive © Continental AG 3/15/2024 40
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Scalablility Enables X-Carline Venhicle

OdH
OdH

e.g. A— vehicle segment e.g. B/C — vehicle segment e.g. D — vehicle segment

Beyond the above shown star topology an optional CAN ring topology can be applied, too.
Any other vehicle architecture with e.g., up to 8 ZCUs can be supported due to modularity and scalability.

ZCU = Zone Control Unit.

HMG TechDay Automotive © Continental AG 3/15/2024 41
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Zone Control Unit Platform
Scalability and Modularity

Continental’s Zone Control Unit Platform supports the market needed variety with
a well-defined scalability and modularity concept

Scalability ‘ Modularity

Ability to support lower and higher-level requirements Exchangeability of solutions to cover the specific
(uC performance, amount of 10s, interfaces,...) needs of the OEMs

superinr A soptea m ﬂ ﬂ E E
Application
Advanced Performance inat part of ZCP)
Medium Performance
el Hesa care
Basic Performance ChaUieralu ASNI D
Zngled Dal coe Upin 1L € Upta Infrastructure
Sinygl e Up 12 ASILE Functions
up b ASIL B

Time Fewiting Srnart Diagross Volege
Syncaronization Malngrnmrll Furstions Banagremen

Conliyuration Configuralion Confliywration Caunliguralivn D|s1r|3ut|on

Flash @ @ & 0 O Flash @ @ @ 0 O Fash @ @ & 0 O Flash @ @ @ @ @ Driver

un L BN B B BN m 9 9909 w9 ® 00 LN *o 00

GAN ® &0 08 . B X N N | e B N B N | N s o B®ee® | | mmm====-

M0 0000 R R Moo oe 000 EHoos 00 AaRpwaRE Ansiog | Dighal | 130 D

Companent e sizo | et | e PHIC  Fume

. J
. J
(Ontinental® HMG TechDay Automotive © Continental AG 3/15/2024 42
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Server-Zone Architecture

Main Interconnection Scheme for Zone Control Unit
.

10BASE 10BASE 10BASE

T1S T1S T1S
ECU ECU ECU

A I I ——

Non intelligent
NIAS Actuator/Sensor

Communication Technology

Ethernet
----- 10BASE T1S (optional)
—_— CAN/CAN FD
LIN

I Wire
(] (]
ZCU = Zone Control Unit; HPC = High Performance Computer; LIN = Local Interconnect Network; CAN = Controller Area Network; CAN FD = Controller Area Network Flexible Data Rate; 10BASE T1S = 10 MBps Multidrop Ethernet via twisted
pair copper wire; NIAS = Non-Intelligent Actuator Sensor
(Ontinental® HMG TechDay Automotive © Continental AG 3/15/2024 43
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Zone Control Unit Platform
Backbone - Content

~

UBATT

. o
. Power Supply
External HW
4
. Watchdog

oo 0
g TR

_ Intelligent

A

N lings =i

Outputs

Digital input P
Wakeup

E gl Controller —

: PR Digital input PN

3 Wakeup

L:) < —Ethernet—» _ <M

T

= . Samd |nputs B >
B HC Voltage Main ) -

Supervision |l Controller Outputs By >

Smart
Power
Distribution

<+—>

uC = Microcontroller, PHY = physical layer, SPI = Serial peripheral interface

~

Main Connector

Backbone Elements

1 | Power supply (scalable in relation to ASIL level)

2 | Communication interfaces (modular and scalable)

3 | Microcontroller supervision (scalable in relation to ASIL level)
A | Microcontroller topology (Co-controller is optional)

5 | Infrastructure functions (modular, partly optional)

[§) | Smart Power Distribution (SPD)

) Security and safety measures are pre-integrated in all backbone variants!

(Ontinental® HMG TechDay

Public
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Zone Control Unit Platform
Flexible Integration Process

Customer/ 3" Party Supplier interface Integration
Process

. i i i
3 g Cooperation Portal f
- Backbone

I 3rd Party
Platform Modules Selection Continental Function Library SESIE

ﬁ:-ﬂ-ﬁ%-ﬁ

________ m smmmme

Stage It It LSD  PMIC  Fuse

Platform Backbone Selection
o ]

Continental

Advanced integration process ensures efficient application development!

@ntinentali\ HMG TechDay Automotive © Continental AG
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Function Application Layer / HW Backbone Provider

Function Application

Layer
Function as a Product
(FaaP)
Services

Public



1 Software complexity
Increases

2 Multiplication of
software suppliers

Limited resources

(©ntinental®

HMG TechDay

Automotive © Continental AG
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Function Application Layer Solutions

Collaboration needed between

HYUNDAI o

We target of MOTOR GROUP
products portfolio’s functions to ensure Architecture fit.

License for assets
Agile Fixed Price for services

. TRADITIONAL AGILE
2 FIXED Scope Resources Time
® o ®
- Plan
VARY driven

HYUMNDAI

MOTOR GROUP
SW Organization

HMG TechDay Automotive © Continental AG 3/15/2024 49
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Vehicle Function

Catalog of “backbone” functions
with “low differentiating
capabilities”

Market leader with classic single
product approach

Support OEM to achieve a timely
and smooth transition to new E/E
architecture.

* |/O = input/output, ** Non-exhaustive capability model

ety

2

J

HW/SW decoupling strategy

Separate hard real-time elements
from high level logic.

Lower layer focuses on I/O*
processing, control algorithm and
safety.

Decoupled artifacts shall link into
OEM architectures.

OEM involvement needed right from the beginning

Cloud
In-vehicle Operating Systems
Middleware Adaptive AUTOSAR™

Embedded Classic AUTOSAR™

Software Defined Vehicle**

Need to fit with OEM unified model
for life cycle management across
different software environments

Complete automatization and
standardization will take years.

Need for expertise and knowledge
to execute these capabilities.

HMG TechDay

Automotive © Continental AG
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Key Take Away

& |

I

\

Function as a Product means software assets and
the services around to ensure seamless integration
and maintenance.

Function as a Product serves every stage of the
OEM Software-Defined vehicles transformation.

Function as a Product targets at first the backbone
functions of the vehicle.

@ntinentali HMG TechDay Automotive © Continental AG
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Enable. Develop. In

Cybersecurity
In-Vehicle

Software

. Continuous
Solutions

Development/
Validation/
Testing

os/ ‘
Middleware

| Data Security i
In-Cloud

SW & HW : . ,
Separation J* - = — e ‘ . Lifecycle |
Management |

Over-the-air
Updates

Public
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